Agilent G1701DA
MSD ChemStation

5973 MSD / ChemStation
Quick Reference

Agilent Technologies
What's New in Revision D.01.00

- A new toolbar has been added to the Top view and an expanded set of toolbars have been added to Data Analysis. Moving the cursor over a toolbar will display tool tips (quick descriptions) for each of the buttons.

- The Sequence user interface or sample log table has been transformed into a spreadsheet user interface.

- During sequencing the ABORT button in the status panel has been changed to Pause. When this is selected, the sequence will pause immediately. When the sequence is started, it will restart the sequence from where it was paused.

- Long file names are supported. Data file and method paths can be up to 100 characters long. The names of individual data files and methods can be up to 50 characters long.

- User Interfaces for selecting or saving files and directories have been enhanced with browse buttons.

- Support for 5973A and 6890A instruments using GPIB has been restored.

- It is now possible to disable Method Resolution for most changes in the 6890 configuration.

- The Manual Tune and Diagnostics / Vacuum Control views have been merged into a single view, Tune and Vacuum Control.

- A Tune Wizard has been provided to simplify the modification of criteria (tune limits, target ratios) used by the tuning algorithms.

- Loading data files in Data Analysis will now preview the chromatogram.

- The method has been expanded to permit printers other than the default printer to be used for reports generated during Run Method.

- Headers in Data Analysis reports are now configurable for the reports generated by Run Method.

- An improved BOOTP service has replaced the previous BOOTP program. The new BOOTP service will not interfere with shutting down or logging off the computer.

- The SICL drivers have been updated to version L.02.01. Version M.01.01 is on the software CD and is for GPIB support.

Online Help

Use the online help to learn about these new features as well as to learn about instrument control, data acquisition, data analysis, methods, sequencing, tuning, and how to use system commands and variables. Troubleshooting the MSD is included to help you diagnose problems.
Using Online Help

To access the online help, select Help Topics from the Help menu in any window, or click the Help button on any dialog box.

### Item Description

- **Hide / Show**: Lets you turn on or off the display of the list of help topics.
- **Back**: Goes back to the previous help topic.
- **Print**: Lets you print the current book or help topic.
- **Contents**: Displays the list of help topics (shown above).
- **Index**: Lets you use keywords to search the help index for a particular topic.
- **Search**: Lets you type a word or phrase and then displays a list of all the topics in the online help that contain those words.

### Help Icons

- ![Book](image) Indicates a book containing more help topics. To open a book, select it then double-click.
- ![Open Book](image) Indicates an open book of help topics. To close an open book, select it then double-click.
- ![Help Topic](image) Indicates a help topic. To jump to a help topic, select it then double-click.
5973 MSD with a 6890 GC

- ALS tray
- Column oven
- ALS tower
- Status display
- Local control panel
- On/off switch
- Keypad
- Status board
- 5973 MSD
- 6890 GC
GC Keypad

The MSD ChemStation software provides instrument control for the 6890 GC. This allows you to use the software, instead of the GC keypad, to program the instrument. However, there are times when you may want to use the keypad to quickly perform one of the following tasks:

- Stop a run
- Display column information
- Prepare a run (manual injection)
- Start a run (manual injection)
- Display the oven temperature
- Display the GC/MSD interface temperature (Thermal Aux 2)
- Display the front injection port temperature
- Display the rear injection port temperature
Instrument Control View

The Instrument Control view is displayed when you start up the MSD ChemStation. This is where you set and monitor instrument parameters. If you are in a different view, select View / Instrument Control when you are ready to set up the system for data acquisition.

Acquisition Status  Lets you tell at a glance the status of the current instrument or run (if any).

Start Button  Lets you start a run. When a run is not in progress, the arrow is green. To start a run, click the green arrow, fill in the Sample Information, and click Start Run. When a run is in progress, the arrow is gray.

This button also shows the current data file name, sample information (if any), and the vial number (1 if no ALS).
Run Time Clock shows the elapsed time since the beginning of the run if a run is in progress. The scheduled run time is shown below the digital clock. When a run is not in progress, the Run Time clock shows the elapsed time since the last run.

Stop Button lets you stop the system when it is in Pre-Run, Run, or Post-Run mode. The stop sign is red when a run is in progress and gray when a run is not in progress.

Logbook Button displays a menu where you can choose to view, open, clear, save, or print a particular logbook.

Help Button displays a menu where you can select an online help topic for the Instrument Control view. Choose Help Topics to go to the online help for the entire system.

Injector Button lets you set parameters for the injector when you have configured your system with an ALS.

Inlets Button lets you set parameters for the GC inlet (injection port) that is configured on your system.

Columns Button lets you configure columns and set up ramped flow and pressure programs.

Oven Button displays a menu that lets you edit GC oven parameters or GC monitor parameters. When the GC is ready, the small square in the upper right corner is green. When the GC is not ready, the square is red.

Aux Button lets you set the temperature of the GC/MSD interface (usually Thermal Aux 2).

MS Button displays a menu that lets you edit MS acquisition parameters, select another tune file, or edit MS monitors.

Monitor Each monitor displays one instrument parameter. See the online help for a description of the instrument monitors.
The software menus shown on the following pages are for an MSD ChemStation in Enhanced Mode.
Top Toolbar

- **Load Sequence** Loads the selected sequence.
- **Save Sequence** Saves the specified sequence.
- **Run Sequence** Saves the specified sequence.
- **Edit Sequence** Lets you set up or modify the sample log table.
- **Print Sequence** Prints the current sequence.
- **Simulate Sequence** Simulates the current sequence.
- **Load Method** Loads the selected method.
- **Save Method** Saves the specified method.
- **Run Method** Runs the current method. The Start Run dialog box is displayed.
- **Edit Method** Lets you modify the method parameters for the current method.
- **Print Method** Prints the current method.
Instrument Control Menus

**Method**
- Run...
- Load...
- Save...
- Edit Entire Method...
- Additional Method Information...
- Print
- Exit

**Instrument**
- Inlet/Injection Types
- GC Edit Parameters...
- GC Plot...
- GC Monitors...
- Acquire RTLock Calibration Data...
- Unlock Method...
- Disable Method Resolution
- Select MS Tune File...
- MS SIM/Scan Parameters...
- Change MSD Temperatures...
- MS Monitors...
- Edit MS Tune Parameters...
- Perform MS Autotune...
- EMF Utilities...

**View**
- Top
- Instrument Control
- Data Analysis (offline)
- Tune and Vacuum Control...

**Window**
- Cascade
- Tile Horizontal
- Tile Vertical
- Arrange Icons
- Arrange Plots and Monitors
- Exit

**Qualify**
- Checkout Tune
- Tune Evaluation
- View Tunes...
- Sensitivity Check
- Software Validation
- Installation Checklist
- Familiarization Checklist

**Help**
- Help Topics
- Using Help
- Review Revision History...
- View Revision Readme File
- About

Select **View / Instrument Control** to access these menus.
Tune and Vacuum Control Menus

Select View / Tune and Vacuum Control from Instrument Control to access these menus.
Data Analysis Menus

Select View / Data Analysis (offline) to access these menus.

The View menu in Data Analysis lets you access other Data Analysis modes (shown on the following pages).
EasyID Menus

- EasyID
  - Co Next Compound
  - Goto Compound #
  - Xpand Chromatographic Window + / - 2 minutes
  - Original Chromatographic Window
  - Graphics Report to the Printer
  - Restart Quick QEdit
  - Set Extract Window Start
  - Set Extract Window Stop
  - Abort Changes and Exit
  - Exit and Save Changes

- Spectrum
  - Draw Next
  - Draw Previous
  - Tabulate
  - Add
  - Subtract
  - Select Library...
  - Edit Strategy...
  - Edit Library...
  - Display Reference Spectra
  - Update Reference Spectrum

- Integrate
  - Integration Parameters
  - Save compound specific integration parameters
  - Remove compound specific integration parameters
  - Integrate

- ChromEval
  - Evaluate Resolution
  - Evaluate Tailing
  - Evaluate Degradation

- View
  - Data Analysis

Select **View / EasyID** in **Data Analysis** to access these menus.

QEdit Menus

- QEdit
  - Co Next Compound
  - Goto Compound
  - Xpand Chromatographic Window
  - Original Chromatographic Window
  - Graphics Report to the Printer
  - QDEL Compound
  - Next File
  - Load Data File...
  - Restart Quick QEdit
  - Abort Changes and Exit
  - Exit and Save Changes

- Spectrum
  - Draw Next
  - Draw Previous
  - Tabulate
  - Add
  - Subtract
  - Select Library...
  - Edit Strategy...
  - Edit Library...
  - Display Reference Spectra

- ChromEval
  - Evaluate Resolution
  - Evaluate Tailing
  - Evaluate Degradation

- Display
  - Normal Qualifiers

- View
  - Data Analysis

Select **View / QEdit Quant Result** in **Data Analysis** to access these menus.
**Parametric Retrieval Menus**

- **File**
  - Load...
  - List Header
  - Take Snapshot
  - Subtract Background (BSB)
  - Print Current View
  - Save Parameters
  - Abort
  - Exit

- **Spectrum**
  - Draw Next
  - Draw Previous
  - Tabulate
  - Add Normalized Subtract

- **Library**
  - Select Library...
  - Edit Strategy...
  - Edit Library...
  - Library Search Report...
  - Read JCAMP File...
  - Write JCAMP File...
  - Subset Library...
  - Add Current Entry

- **Retrieve**
  - Set Parameters...
  - Select Library...
  - Continue Results

- **Structures**
  - Select Structure Database...
  - Set Structure Parameters...

- **Options**
  - Select Normalization Ion
  - Extend Database Headers...
  - Command Line
  - Stack
  - Manual Integration
  - Copy Window...
  - Reset Windows

- **View**
  - Standard Menu
  - Library Entry Only
  - TIC and Library Entry
  - Unknown and Library Entry
  - Unknown, Library Entry, and Difference

- **Help**
  - Help Topics
  - About

Select **View / Parametric Retrieval** in Data Analysis to access these menus.

**Align GC Menus**

- **Alignment**
  - Show Current Method Alignment Points
  - Perform Alignment
  - Restore Alignment Chromatograms
  - Abort
  - Exit/Save

- **View**
  - Data Analysis

Select **View / Align GC** in Data Analysis to access these menus.
Review Peak Purity Menus

Select View / Review Peak Purity in Data Analysis to access these menus.

Quick Screener Menus

Select View / Results Screener in Data Analysis to access these menus.

RTLock Menus

Select View / RTLock Setup in Data Analysis to access these menus.
Data Analysis Toolbar Buttons

- **Load Data File**: Loads the selected data (.D) file and displays the total ion chromatogram (TIC) for that file.
- **Load Method**: Loads the selected method (.M) file.
- **Save Method**: Saves any changes made to the current method.
- **Take Snapshot**: Displays the data that has been acquired up to the time the snapshot is activated. GC/MS data only.
- **Print**: Lets you print the selected window, the TIC and spectrum, or the current method.
- **Copy Window**: Lets you copy the selected window to the clipboard.
- **Reset Windows**: Rearranges the graphics windows to their default positions.
- **Execute Command**:Executes the command that is typed into the command line.
- **Abort**: Stops a command or macro.
- **Toggle Command Line**: Turns the display of the command line on or off.
- **Edit Colors**: Lets you adjust the colors of various display items in Data Analysis.
- **Toggle Graphics**: Lets you minimize or maximize the displayed graphics.
- **Close Screen Reports**: Closes the currently displayed screen reports.
- **EasyID**: Lets you update expected retention times and ion ratios for MS data in an existing quantitation database on a compound-by-compound basis.
- **QEdit Quant Result**: Lets you review and edit quantitation results once a data file has been quantitated.
- **Generate Signal-to-Noise Report**: Lets you perform a signal-to-noise check and then display or print the report.
- **Review Peak Purity**: Helps you detect overlapping peaks (multiple-component peaks) in your chromatogram.
- **Retention Time Locking**: Accesses the RTLock Setup view which is used for retention time locking tasks.
- **CUSTOMTOOL1**: Lets you run a user-created macro. This macro must first be created and then named CUSTOMTOOL1. See the online help for Using and Writing Macros, and Data Analysis Commands.
- **CUSTOMTOOL2**: Lets you run a user-created macro. This macro must first be created and then named CUSTOMTOOL2. See the online help for Using and Writing Macros, and Data Analysis Commands.
- **CUSTOMTOOL3**: Lets you run a user-created macro. This macro must first be created and then named CUSTOMTOOL3. See the online help for Using and Writing Macros, and Data Analysis Commands.
Draw Chromatogram  Redraws the original chromatogram of the current data file without labels or integration marks.

Scale Chromatogram  Scales the selected chromatogram by the specified scale factors.

Extract Ion Chromatogram  Extracts and displays extracted ion chromatograms (EICs) from the total ion chromatogram (TIC) of the current data file.

Merged Format  Causes extracted ion chromatograms to be displayed overlaid on each other.

Overlay Chromatograms  Lets you select multiple chromatograms to be displayed superimposed on each other.

AutoIntegrate  Tries to find the best integration parameters for the current chromatogram and then integrates the chromatogram.

Integrate  Integrates the current chromatogram using parameters set for the current integrator.

Subtract Spectrum  Subtracts one spectrum from another and displays the difference.

Select Library  Lets you select the libraries that will be used for PBM searches of the currently selected spectrum.

Library Search Report  Integrates the current TIC, searches the current library, and generates a report.

Set Up Quantitation  Lets you set up a quantitation database by specifying quantitation database globals and entering compounds into the database.

AutoQuant Setup  Provides a semi-automated way to create a quantitation database.

Edit Compounds  Lets you review and edit information in the quantitation database compound-by-compound.

Update Calibration  Lets you add, delete, or update a calibration level in the current quantitation database.

Calculate Quant Report  Quantitates the current file and generates a quantitation report.

Generate Quant Report  Generates a quantitation report for a file that has already been quantitated.

Print Quant Report  Prints the quantitation report.

Custom Reports  Starts the Custom Reports software. If the method does not have a quantitation database, or no data file is loaded, you can use default values.

Print Custom Report  Prints the custom report template specified by the method using the current data file.

Online Help  Displays the MSD ChemStation online help.
To vent (shut down) the MSD

1. If your system is equipped with a gauge controller, switch off the triode gauge controller.

2. Before venting a CI MSD, press the Gas Off button (turns off the reagent gas flow and closes the isolation valve.)

**WARNING**
On a CI MSD, the Gas Off light must be on when the MSD is venting.

3. From the Tune and Vacuum Control view, select Vent from the Vacuum menu in the software. Follow the instructions presented.

4. Set the GC/MSD interface heater and the GC oven temperatures to ambient (25°C).

**WARNING**
If you are using hydrogen as a carrier gas, the carrier gas flow must be off before turning off the MSD power. If the foreline pump is off, hydrogen will accumulate in the MSD and an explosion may occur. Read the Hydrogen Carrier Gas Safety Guide (5955-5398) before operating the MSD with hydrogen carrier gas.

**CAUTION**
Be sure the GC oven and GC/MSD interface are cool before turning off carrier gas flow.

5. When prompted, turn off the MSD power switch.

6. Unplug the MSD power cord.

7. Remove the analyzer cover.

8. Turn the vent valve knob counterclockwise only 3/4 turns or until you hear the hissing sound of air flowing into the analyzer chamber.

**WARNING**
Allow the analyzer to cool to near room temperature before touching it.

**CAUTION**
Always wear clean gloves while handling any parts that go inside the analyzer chamber.

**WARNING**
When the MSD is vented, do not put the ChemStation into the Top view. Doing so will turn on the interface heater.
To pump down (start up) the MSD

1. Make sure your system meets all of the following conditions before you pump down:
   - The vent valve is closed (the knob is turned all the way clockwise.)
   - All other vacuum seals and fittings are in place and fastened correctly. (The front side plate screw should not be tightened unless hazardous carrier or reagent gases are being used.)
   - The MSD is connected to a grounded power source.
   - The GC/MSD interface extends into the GC oven.
   - A conditioned capillary column is installed in the GC inlet and in the GC/MSD interface.
   - The GC is on, but the heated zones for the GC/MSD interface, the injection port, and the oven are off.
   - Carrier gas of at least 99.999% purity is plumbed to the GC with the recommended traps.
   - If hydrogen is used as carrier gas, carrier gas flow is off and the front side plate thumbscrew is loosely fastened.
   - The foreline pump exhaust is properly vented.

2. Select **Tune and Vacuum Control** from the **View** menu.

3. Select **Pump Down** from the **Vacuum** menu.

4. When prompted, switch on the MSD.

5. Press lightly on the side board to ensure a correct seal.

   The rough pump will make a gurgling noise. This noise should stop within a minute. If the noise continues, there is a large air leak in your system, probably at the side plate seal, the interface column nut, or the vent valve.

6. Once communication with the PC is established, click **OK**. Within 10 to 15 minutes the diffusion pump should be hot, or the turbo pump speed up to 80%. The turbo pump should eventually reach 95%.

   **CAUTION**
   If these conditions are not met, the foreline pump will be shut off. You must then power cycle the MSD. If the MSD does not pump down correctly, see the online help for information on troubleshooting air leaks and other vacuum problems.

7. When prompted, turn on the GC/MSD interface heater and GC oven. Click **OK** when you have done so. The software will turn on the ion source and mass filter (quad) heaters. The temperature setpoints are stored in the current autotune (*.u) file.

   **CAUTION**
   Do not turn on any GC heated zones until carrier gas flow is on. Heating a column with no carrier gas flow will damage the column.

8. After the message **Ok to run** appears, wait two hours for the MSD to reach thermal equilibrium.

   **CAUTION**
   Data acquired before the MSD has reached thermal equilibrium might not be reproducible.
To tune your MSD

You should tune the MSD periodically to maintain its optimum performance. Tuning is the process of adjusting MSD parameters so the instrument meets certain performance criteria. How often you should tune is determined by the number and type of samples you are running, as well as the overall condition of your system.

Note Always tune the MSD with the same GC oven temperature and column flow, and the same analyzer temperature that will be used for data acquisition.

Keep the Tune reports in a notebook so that successive reports can be easily compared.

To use Autotune

1. From the Instrument Control view, select Perform MS Autotune from the Instrument menu.

2. Select one of the following options, depending on the instrument performance required by your application, then click OK.
   - Autotune
     Results in maximum sensitivity over the full scan range.
   - Low Mass Autotune
     Tuned for the low-mass range.
   - Standard Spectra Tune
     Results in a standard response over the full scan range. This option may reduce sensitivity.
   - QuickTune
     Adjusts the peak width, mass assignment, and abundance without changing ion ratios.

3. Review the Tune report.

4. To view the history of tune results, select View Tunes from the Qualify menu.

To use Manual Tune

Manual tuning lets you interactively set the MSD parameters, such as lens voltages and tuning masses, to values that meet the needs of your particular analysis. You can often obtain greater sensitivity than you can with autotune.

Manual tuning allows you to ramp individual parameters and to specify the range and step size for the ramp. The results of the ramp are displayed visually with the optimum value for the parameter clearly marked on the plot.

You can acquire two types of data in manual tune: profile scans (plots the abundance and peak shape of the tune masses) and spectrum scans (scans plot response across the entire mass range).

See the online help for more details about manual tuning.
To acquire data

To set up the GC for use with the MSD
1. Select Instrument / Inlet/Injection Types. Select the appropriate injection source and select the Use MS checkbox. Click OK.
2. Click the Aux button. Verify that you are using auxiliary channel 2, the heater is on and set to the desired temperature, and that MSD is selected as the Type. Click OK.
3. Click the Columns button. Verify that the detector is MSD and that Vacuum is selected for Outlet psi. Click OK.

To inject a sample manually
1. Select Manual as the injection source on the Inlet and Injection Parameters box.
2. Press the Prep Run key on the GC keypad. This cancels the gas saver flow, brings the inlet flow to its setpoint value, and closes the purge valve (for splitless injection only).
3. Select Run from the Method menu from the Top or Instrument Control view.
4. When the Start Run box appears, specify the sample information:
   a. Specify a unique data file name for the sample.
   b. (optional) Fill in the Operator Name, Sample Name, and Misc Info fields to document the injection.
   c. Make sure that the Data Acquisition option is selected.
   d. (optional) Select the Data Analysis option if you want to generate any Data Analysis reports specified in the method.
5. Click Run Method to initiate the run. If the temperatures are stable, the Prepare To Inject box appears. Otherwise, the message Waiting for GC ready is displayed.
6. When the GC temperatures have stabilized (the Pre Run light on the GC is steady), inject the sample and press Start on the GC.

CAUTION
Do not inject before the GC is ready. This will cause inconsistent results.

To inject a sample manually
1. Select Manual as the injection source on the Inlet and Injection Parameters box.
2. Press the Prep Run key on the GC keypad. This cancels the gas saver flow, brings the inlet flow to its setpoint value, and closes the purge valve (for splitless injection only).
3. Select Run from the Method menu from the Top or Instrument Control view.
4. When the Start Run box appears, specify the sample information as described below:
   a. Specify a unique data file name for the sample.
   b. (optional) Fill in the Operator Name, Sample Name, and Misc Info fields to document the injection.
   c. Make sure that the Data Acquisition option is selected.
   d. (optional) Select the Data Analysis option if you want to generate any Data Analysis reports specified in the method.
5. Click Run Method to initiate the run. If the temperatures are stable, the Prepare To Inject box appears. Otherwise, the message Waiting for GC ready is displayed.
6. When the GC temperatures have stabilized (the Pre Run light on the GC is steady), inject the sample and press Start on the GC.

CAUTION
Do not use the Start button on the GC to start a run when using the autosampler.
To analyze MS data

To load a data file
1. In Data Analysis, select Load from the File menu.
2. Select a data file (double-click on a file name or type a name and click OK). The chromatogram for the data file is loaded and displayed in window [2].

To integrate a chromatogram
1. If the integrator you wish to use is not currently selected, open the Chromatogram menu and click Select Integrator. Choose an integrator and click OK.
2. Select Integrate from the Chromatogram menu.
3. (optional) Select List Results from the Chromatogram menu. A report of tabulated results is displayed on the screen. When you are finished viewing the results, click Done.

To select a spectrum
- Double-click the right mouse button on the time point of interest in the chromatogram. The spectrum appears in window [1].

To zoom in
1. Position the pointer at one corner of the area you wish to expand in a chromatogram or spectrum.
2. Press and hold the left mouse button while dragging the mouse to select the area you wish to expand.
3. Release the mouse button. The selected area expands to fill the existing window.

To zoom out
1. Position the pointer anywhere in the zoomed window.
2. Double-click the left mouse button.

To average spectra
1. Position the pointer in the chromatogram at the starting time for the range you want to average.
2. Press the right mouse button while dragging the mouse to the end of the range you want to average.
3. Release the mouse button. The spectra in the selected range are averaged and the averaged spectrum is displayed in window [1].

To add two spectra
1. Select a spectrum (double-click the right mouse button in the chromatogram).
2. Select a second spectrum (double-click the right mouse button in the chromatogram).
3. Select Add from the Spectrum menu. The two spectra are added together and the resulting spectrum is displayed in window [1].

To subtract two spectra
1. Select a spectrum (double-click the right mouse button in the chromatogram).
2. Select the spectrum to be subtracted (double-click the right mouse button in the chromatogram).
3. Select Subtract from the Spectrum menu. The spectrum selected in Step 2 is subtracted from the spectrum selected in Step 1 and the resulting spectrum is displayed in window [1].

To subtract background spectra
1. Select a spectrum or average a range of spectra to subtract from the data file.
2. Select Subtract Background (BSB) from the File menu. The system performs the following tasks:
   - The selected spectrum is subtracted from every scan in the current data file.
   - The subtracted data is stored in a BSB subdirectory in the same directory as the data file.
   - The subtracted data file becomes the current data file and is displayed in window [2].
To use spectral libraries

To integrate and search peaks
Use the following procedure to integrate a total ion chromatogram and automatically generate a library search report for each peak detected.

1. In Data Analysis, load a data file. The TIC is displayed.
3. When the Library Search Report Options dialog box appears, select the options you want for the library search report:
   - Select either Summary or Detailed to determine the report format.
   - Select one or more destinations (Screen, Printer, and File).
   - Select an Integration Parameter File (leave the field blank to autointegrate using the ChemStation integrator).
   - Select which spectrum from each peak to use (Apex, Apex - Start of Peak, Apex - Background at time, or Peak Average).
4. Click OK to initiate the search.
   - The chromatogram is integrated and a spectrum from each peak is searched. The results of the integration appear on the screen. The library search report is sent to the destinations selected in Step 4.
5. Select Chromatogram / Integration Results to view the tabulated integration results.

To search a single spectrum
1. In Data Analysis, load a data file. The TIC is displayed.
2. Select a spectrum. The selected spectrum appears in a window below the chromatogram.
3. Initiate the library search by double-clicking the right mouse button in the window containing the spectrum.
   - When the search is complete, the search results appear on the screen. The spectrum for the unknown, the reference spectrum you select from the list of hits, and, if available, the chemical structure of the reference compound is displayed.
4. To view other spectral data:
   - Click on another compound in the hit list to display a different reference spectrum.
   - Select the Difference checkbox to display the difference between the unknown and the reference spectra.
5. To view other information:
   - Click the Statistics button to display information about the quality of each hit found in the list.
   - Click the Text button to view the header information stored in the library for the current reference spectrum.
6. Click the Print button to print a copy of the displayed spectra.
7. Click the Done button to clear the library search results from the screen.
Maintenance Schedule

Maintenance tasks are described in the hardware manuals supplied with your system. How often you need to perform system maintenance may vary for your system. Keep a maintenance record.

**Every day**
- Check, and if necessary, replace the septum.
- Check the tightness of the injection port liners.
- Check the tightness of the column nuts.

**Every week**
- Check the foreline pump fluid level.
- Change the injection port liners and O-rings.

**Every month**
- Clean the split/splitless inlet vent line trap.
- Check for leaks (inlet, column connections).

**Every three months**
- Replace gas cylinders (when below 500 psig).

**Every six months**
- Replace the foreline pump fluid.
- Check, and if necessary, refill the calibration vial.

**Every year**
- Check, and if necessary, replace the diffusion pump fluid.
- Recondition or replace internal and external traps and chemical filters on the GC.

**As needed**
- Tune the MSD.
- Clean the ion source.
- Replace the carrier gas trap.
- Replace worn out parts (filaments, EM, etc.).
- Replace the column.
- Lubricate seals.

Safety warnings

**WARNING**
Do not perform maintenance with the MSD on or connected to its power source unless specifically instructed to by documentation supplied with the MSD.

**WARNING**
The GC/MSD interface can be on and at a dangerously high temperature even though the MSD is off. After it is turned off, the GC/MSD interface cools very slowly. Make sure all parts have cooled before handling them.

**WARNING**
Be careful when working behind the GC. During cool-down cycles, the GC will emit hot exhaust that could cause burns.

**WARNING**
The oil trap provided for your foreline pump stops only foreline pump oil. If you are analyzing toxic chemicals or using toxic solvents, remove the oil trap and use a hose to route the foreline pump exhaust out of your laboratory.

**WARNING**
Use chemical-resistant gloves and safety glasses when replacing pump fluid. Avoid all contact with the fluid.

**WARNING**
The insulation around the inlets, detectors, valve box, and insulation cups is made of refractory ceramic fibers (RCF). Avoid inhalation of RCF particles. Ventilate your work area, wear long sleeves, gloves, safety glasses, and a disposable respirator. Dispose of insulation in a sealed plastic bag. Wash your hands with mild soap and cold water after handling RCFs.
Operating Tips

- Back up your data and methods **regularly** to avoid loss of data if the files are accidentally overwritten or deleted, or if a hardware problem develops with your disk drive.

- Make sure the tune file you are using is appropriate for your samples.

- Save Tune reports in a notebook for future reference.

- Perform system maintenance as indicated by the maintenance schedule in the GC and MSD hardware documentation. Keep a record of all maintenance performed.

- When venting the MSD, take advantage of the cool GC to do maintenance such as replacing inlet liners, septa, etc.

- After pumpdown, wait **at least 2 hours** for the MSD to reach thermal equilibrium before tuning or acquiring data.

- Optimum sensitivity generally occurs at column flow rates of 12 ml/minute or less.

- When injecting volumes greater than one microliter, use the pulsed splitless mode and increase the initial oven temperature 10 – 20 °C.

- For splitless injections, pulsed splitless mode gives more quantitative sample transfer onto the column. A pulse pressure of twice the initial inlet pressure is typical.

- Selecting **Constant Flow** mode will provide the most efficient separation in most cases. It also results in constant sensitivity throughout the temperature program.

- For a new column, check that the column nuts are still tight after the first few oven temperature cycles.

- Use the Config Status keys on the GC keypad to set the 3 display items most important to you (time remaining, oven temp, etc.). These are then always visible regardless of which ChemStation view is on top.

- Rinse and refill autosampler wash vials. Do not add more solvent to a partially full vial.

- Use the following table as a guide to using the SIM or Scan acquisition modes.

<table>
<thead>
<tr>
<th>Task</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze a mixture with unknown components.</td>
<td>Scan</td>
</tr>
<tr>
<td>Analyze a mixture with known components in unknown amounts (quantitate).</td>
<td>Scan or SIM</td>
</tr>
<tr>
<td>Identify the presence of a few known compounds at low levels within a mixture.</td>
<td>SIM</td>
</tr>
</tbody>
</table>

- When choosing masses for SIM, use the exact mass printed in the Tabulation report, not the nominal mass annotated on the spectrum display. This provides more accurate data.

- When doing SIM analysis, use low resolution mode unless you are trying to determine the ratios of masses one amu apart. Low resolution provides maximum sensitivity and repeatability.

- Choose the narrowest scan range that still produces good library search results. This allows more spectra across the peak and better quantitation.
Troubleshooting Tips

**MSD is on, but status flashing “Server not found! Check LAN connection”**

This is normal when the MSD is initially turned on. It means the ChemStation has not yet established contact with the MSD. If the flashing continues after the pumpdown is initiated:

1. Temporary power failure interrupted communications
2. Bad connection between the MSD and the ChemStation and/or the hub

**No peaks**

1. Incorrect sample concentration
2. No analytes present
3. Syringe missing or not installed correctly (ALS only)
4. Empty sample vial
5. Injection in split mode instead of splitless mode

**Tailing peaks**

1. Active sites in sample path
2. Injection too large
3. Injection port too cool
4. Column flow too low
5. GC/MSD interface or ion source too cool

**Peaks with flat tops**

1. Solvent delay time too short
2. Display scale is wrong
3. Injection too large
4. Electron multiplier voltage too high

**Peaks with split tops**

1. Bad injection technique
2. Injection too large

**Rising baseline**

1. Column bleed
2. Other contamination

**Retention time (RT) drift**

1. Column has been shortened (shorter RT)
2. Old column (shorter RT)
3. Active sites in sample path (longer RT)
4. Reduced column flow (longer RT)
5. Injection port leak (longer RT)
6. Initial oven temperature changed (up = shorter RT, down = longer RT)

**Poor sensitivity**

1. Incorrect tuning
2. Tune file does not match type of analysis
3. Incorrect temperatures
4. Incorrect sample concentration
5. Leaking injection port
6. Incorrect split ratio
7. Purge off time in splitless mode too short
8. Excessive pressure in the MSD
9. Dirty ion source
10. Air leak
11. Detector is not working correctly
12. Poor filament operation
13. Incorrect mass filter polarity
**Poor repeatability**

1. Dirty syringe needle
2. Leaking injection port
3. Mismatched injection port liner and injection size
4. Loose column connections
5. Variations in pressure, column flow, and temperature
6. Dirty ion source
7. Loose connections in the analyzer
8. Ground loop

**Inconsistent peakwidths**

1. Incorrect tuning
2. No PFTBA in calibration vial
3. Calibration valve failure
4. Dirty ion source
5. Worn out electron multiplier
6. MSD has not had enough time to reach thermal equilibrium
7. Large variations in the temperature of the lab

**High background in mass spectra**

1. Air leak
2. Foreline or vacuum manifold pressure too high
3. Other contamination

**Ions at m/z 18, 28, 32, and 44**

1. Detector vented recently (residual air and water)
2. Air leak

**Isotopes missing or isotope ratios incorrect**

1. Incorrect tuning
2. Dirty ion source
3. High background
4. Electron multiplier voltage too high
5. Repeller voltage too high
6. High scan speed (Scan mode)
7. Low dwell time (SIM mode)
8. Peaks too wide or too narrow
9. Repeller and ion focus leads have been reversed

**Foreline or vacuum manifold pressure too high**

1. Excessive column flow
2. Air leak
3. Diffusion pump fluid level too low
4. Diffusion pump fluid is contaminated
5. Foreline pump oil level too low
6. Foreline pump oil is contaminated
7. Constricted foreline hose (this would cause the vacuum manifold pressure to be too high but the foreline pressure to be too low)

Refer to the Troubleshooting the MSD section of the online help for more detailed information.
What's in this Book

- What's New in Revision D.01.00, 2
- Using Online Help, 3
- 5973 MSD with a 6890 GC, 4
- GC Keypad, 5
- Instrument Control View, 6
- Software Menus (Enhanced Mode), 8
- Data Analysis Toolbar Buttons, 16
- To vent (shut down) the MSD, 18
- To pump down (start up) the MSD, 19
- To tune your MSD, 20
- To acquire data, 21
- To analyze MS data, 22
- To use spectral libraries, 23
- Maintenance Schedule, 24
- Operating Tips, 25
- Troubleshooting Tips, 26

Document History

First Edition, 9/03
G1701 DA MSD ChemStation
Rev. D.01.00

*G1781-98858*

Manual Part Number
G1701-90050

Copyright © 2003
Agilent Technologies
Printed in U.S.A. 9/03

Printed on recycled paper